Loqistical Planning and Cost Estimation for a
Student-Based Live Streaming Studio at WP

An Interactive Qualifying Project Report
submitted to the faculty of

WORCESTER POLYTECHNIC INSTITUTE

in partial fulfillment of the requirements for the
degree of Bachelor of Science

by:
Daniel Colgate
JinjiaOu

Date:
April 13, 2023

Report Submitted to:
Professor Frederick Bianchi
Worcester Polytechnic Institute

This report represents the work of WPI undergraduate students submitted to the faculty as evidence of completion of
a degree requirement. WPI routinely publishes these reports on its website without editorial or peer review. For
more information about the projects program at WPI, please see: http://www.WPI.edu/Academics/Projects.



http://www.wpi.edu/Academics/Projects

Table of Contents

Abstract
4
Executive Summary
5
Background
7
The Concept of Live Streaming
7
Room Acoustics
8
Computer Software/Hardware
13
Audio Equipment
14
Cameras
16
Lighting
17
Cables
18
Methodology
20
Room Acoustics Calculations
20
Proposed Room Treatment
23
Audio Equipment
26
Audio Cables
32
Audio Software
33
Video, Lighting, and Livestreaming Software
34
Video Cameras
35
Video Cables
38
Lighting & Other
40
Results & Findings
41
Computer Installation
41
Camera Installation
47
Wiring
49

Acoustics Calibration using Room EQ Wizard

51



Beginner’s Manual to the Live Streaming Studio

52
How to Power on the Studio
52
How to Add a Camera in VMix
53
How to Add an Audio Input in Ableton Live
54
How to Set Up a Livestream
55
Sending a Livestream to Vimeo
55
Conclusion
57
Works Cited
58
Appendices

61



List of Figures

Table A: Total Technical Cost of the Live Streaming Studio

Figure 1.1: Types of Room Modes °
Figure 2.1: Room Modes Plot "
Figure 2.2: Acoustic Designs for Studio and Control Rooms *
Table 2.1: Cost Analysis of Acoustic Treatment “
Table 2.2: Cost Analysis of Audio Equipment =
Table 2.3: Cost Analysis of Audio Cables i
Figure 2.3: Backside of the Mevo Start Live Streaming Camera .
Figure 2.4: Blackmagic Design Pocket Cinema (4K) with Battery and 64GB Memory Card %
Table 2.4: Total Cost of Video Transmission ¥
Figure 2.5: Chauvet DJ 6Spot RGBW 6x9W System >
Table 3.1: Comparison of SSDs and HDDs *
Figure 3.1: Example of Memory Usage while Streaming on OBS ¥
Figure 3.2: Scores for CPUs, Courtesy of Puget Systems v
Table 3.2: Total Cost of Streaming Computer *
Figure 3.3: Available ports on the D5300 *
Figure 3.4: Full Proof of Concept for the Livestreaming Studio Y
Figure 3.5: Audio Equipment Wiring Guide *
Figure 4.1: Blank Lightjam Project >
Figure 4.2: Live Capture Lever (LV) on a Nikon D5300 Camera N
Figure 4.3: Blank vMix Project :,

Figure 4.4: Adding a Camera to vMix

54



Abstract

The purpose of this project was to fully research and propose a live streaming studio with
a budget of $75,000. The live streaming studio was meant as a lab to help teach students by
allowing them to work with all aspects of a live streaming studio. The audio, video, and software
components of the livestream were each carefully researched and a proposed design for the
studio was developed. This report details and outlines the research, consideration, and ultimate

decision on how this studio should be constructed.



Executive Summary

The goal of the project was to design the technical aspects of a live streaming studio,
from the ground up, in WPI, so that the students may use it to experiment with live video
production. The total budget to accomplish this is estimated to be $75,000. To do this, the studio
was split into several sections: acoustics, audio, software, video, computing & encoding, and
lighting & other.

While researching each of these sections, certain recent technological advancements were
identified as targets for the live streaming studio. For example, quadratic residue diffusers use
concave surfaces to diffuse sound evenly around the room, and BNC cables, which were created
to be durable in order to deliver electronic information reliably.

To make use of these discoveries, proposed designs for the technical aspects of the
studio, which is 15 feet by 10 feet in surface area, had to account for everything interconnecting
with each other. The proposed video camera, the Blackmagic Design Picket Cinema 4K, could
livestream video in up to 4K, meaning that if the studio wanted to be capable of live streaming in
4K, all of the components that handled video transmission had to be capable of live streaming in
4K as well. The reverse is also true: If the camera was the only thing that could live stream in
4K, it could be replaced with a cheaper camera that would only move up to HD. The other
components followed suit, and a hypothetical list of components in the studio was made.

In order to prove the viability of the components, a proof of concept was made involving
the audio input, the HD video input, and the livestreaming software, vMix. After discovering
some input issues and camera faults, the proof of concept could receive both the audio and video
and encode it in HD, making it ready to be livestreamed. While not proving everything, it

showed that the logic behind out methodology was sound.



After all the above, the total cost of each section was added up, and resulted in the

proposed technical aspects of the room totaling up to be $18,497.44, well below the initial

budget of ~$75,000, but not taking into account outside costs such as labor:

Section Name Price
Acoustics Acoustic Treatment $5,320.00
Audio Audio Equipment $3,370.00
Audio Audio Cables $370.00
Software Ableton Live $450.00
Software Lightjams $125.00
Software vMix 4K $700.00
Software Vimeo Advanced+ $780.00
Video Video Transmission $4,720.82
Lighting & Other Light Rack and UPS $647.00
Encoding Streaming Computer $2,014.62
Total: $18,497.44

Table A: Total Technical Cost of the Live Streaming Studio.




Background

The Concept of Livestreaming

Although the concept of a “live stream” may seem hip and modern, live streaming
existed as early as 1890, when the French Théatrophone service used telephone lines to
broadcast live performances of theater and opera to its paying subscribers. The service continued
broadcasting music and intermittent news updates until 1932, when the mainstream adoption of
the radio and phonograph rendered it obsolete. A similar service called Muzak operated in
America from 1934 to 1981, which streamed music into elevators and workplaces. Another
service, the Telephone Music Service, allowed patrons of bars in Pittsburgh to send music
requests to an operator though special jukebox telephones from 1929 to 1997. The revenue from
the jukeboxes was shared between the music service and the tavern owners. (Wikipedia
Contributors, 2022)

Throughout the later 20th century, the invention of computer networks allowed users to
communicate across the globe. Powerful home computers, advanced internet infrastructure, and
novel data compression techniques eventually supported the bandwidths required for live
transmission and playback of video and audio. The first band to ever perform live over the
internet was Severe Tire Damage on June 24, 1993. Their performance in Palo Alto, California
was watchable as far away as Australia. Although the quality of the live stream was poor by
today’s standards (only 152x76 pixels), this was an impressive feat at the time. (Wikipedia
Contributors, 2022)

Over the next decade the internet became faster and increasingly commercialized. Live

streamed internet broadcasts became increasingly common. RealAudio Player was one of the



first media player software capable of streaming over the internet, and it was used by ESPN to
stream the first live internet broadcast of an MLB game in 1995. In 1999 Bill Clinton
participated in the first presidential webcast. (Wikipedia Contributors, 2022)

In the modern day, live streaming has become ubiquitous. Anyone with a smartphone and
a decent internet connection can easily start a live stream in a matter of seconds. Platforms such
as Youtube, Twitch, Facebook, and Vimeo provide convenient platforms for users seeking to
distribute their content to hundreds, thousands, or even millions of viewers. For some people,
live streaming has become a full-time career. Revenue can come from a number of sources
including advertisers, merchandise, affiliate programs, and donations directly from viewers
(Bybyk, 2022). From musical performances to esports, live streaming is an industry on the rise.

Room Acoustics

The first step in planning a live streaming studio is making sure the sound quality is the
best it can be. A poorly planned room can ruin the quality of even the best musical performances.
This section describes the basic principles of acoustic treatment and design, which will later be
applied to the design of the livestreaming studio at WPI. For simplicity, assume all of the
information in this section is cited from Everest and Pohlmann (2021) (except for the parts that
are specifically cited from elsewhere). We assume the reader already has a basic concept of
sounds as waves with frequencies and amplitudes.

“Reverberation” is a familiar and immediately noticeable acoustic property of any room.
A reverberant room may add a bright, spacious quality to music, but it will also blur notes and
syllables together, making speech difficult to understand. Inversely, if a room is not reverberant
enough it may sound dry or “dead”. Reverberation can be quantified using what is known as the

RTeo value (also called the “reverberation time”), defined as the amount of time for sound energy



in a room to decay by 60 dB. A room covered in acoustically reflective surfaces such as
hardwood tables or ceramic tiling will have a higher RTeo and will therefore sound more
spacious compared to a room with a lot of absorptive surfaces such as carpeting and drapery.

To further complicate things, different frequencies of sound decay at different rates —
some surfaces are excellent at absorbing lower frequencies while others only absorb higher
frequencies. All surfaces can be characterized by an absorption coefficient (a), which ranges
from 0 to 1 and describes how much sound energy the surface absorbs per unit of area. An open
window, for example, will have an absorption coefficient of 1.0 because no sound is reflected
back. Retailers of acoustic paneling usually provide data sheets listing their material’s absorption
coefficients at a few standard frequency bands. Some brands even advertise coefficients greater
than 1.0, but this is due to a technicality in the way the values are measured. When doing
calculations, the coefficients should be rounded down to 1.0 whenever this happens.

The Sabine Equation, devised in the 1890s by Wallace Clement Sabine, is a widely used
equation for estimating the value of RTeo given the absorptivity of a room at a particular
frequency:

0.049V
RT60 = A

Where V is the volume of the room in cubic feet, and A is the total absorption of the room
measured in units of sabins. The total absorption A can be calculated by adding together the
surface areas of everything in the room multiplied by their absorption coefficients. 1 square foot
of material with a=1.0 will contribute 1 sabin of absorption. For reference, a typical college
student will provide about 5.0 sabins at frequencies above 1000 Hz but only about 2.5 sabins at
250 Hz.

Recording spaces will often have absorptive paneling mounted on the walls to absorb

middle and high-range frequencies. Spacing absorbing panels apart from each other and
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mounting them slightly away from the wall can make them more effective by increasing their
exposed surface area. For peak efficiency, the absorbers should be placed ¥ wavelength away
from the wall, which is where air particles will have the greatest velocity (though a 2-inch gap is
usually wide enough). Low frequencies are reduced using special absorbers called “porous bass
traps”, which often look like wedges placed along the coroners of the room where low frequency
energy tends to gather (Sweetwater, 2022). Additionally, mounting the panels in a way that
makes them easy to rearrange and remove can allow users of the room to tailor the absorptivity
of the room to their liking, creating a more versatile recording space.

The next part of acoustic design to consider are standing waves. When a sound wave hits
one or more walls, it is reflected in a new direction. The reflected sound is then “stacked” on top
of the original wave. If the two waves are out of phase, they cancel out. However, if they are in
phase they combine into a more powerful wave in a process called constructive interference.
Certain frequencies of sound in a room will combine constructively multiple times and form
standing waves that appear to oscillate in a single area. Standing waves are a huge problem in
acoustics because they can significantly increase or decrease the intensity of specific frequencies,
depending on where a listener is positioned. These frequencies are known as room modes, and
they are unique to the geometry of a room. Large auditoriums will have modes at lower
frequencies than small recording studios. In a six-sided box-shaped room there are three kinds of
modes: axial, tangential, and oblique. Axial modes are the strongest modes and result from sound
reflecting off of a pair of two opposite-facing walls. Tangential modes are the result of sound
reflecting off of two pairs of opposite walls and are typically 3 dB weaker than axial modes.
Obligue modes are the weakest (6 dB below axial) and result from reflections on all three pairs

of walls. These three types are illustrated in Figure 1.1:
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Axial Tangential Oblique

Figure 1.1: Types of Room Modes.
The mode frequencies for a box shaped room can be easily calculated using the following

formula:

Frequency = E\/p—z + q—z + r_Z
2. L W2 H?

Where c is the speed of sound (1,130 ft/sec), L W H are the room’s dimensions, and p q r
are all integers greater than or equal to 0. A computer program can very quickly compute all
possible room modes within a given frequency band. It is worth mentioning that altering a room
to have a non-cubic shape will not remove standing waves. Instead, it will shift them around and
make them more complicated to predict.

At high frequencies, there are so many modes that they blend together and become
unnoticeable. However at lower frequencies, room modes are spaced out and can create audible
defects in the sound. To reduce the severity of this problem, specialized absorbers called
resonating bass traps are tuned to selectively absorb specific frequencies (Sweetwater, 2022).
Resonating bass traps have been used by humans for a very long time; Medieval churches in
Scandinavia have been found with hollow pots embedded in the walls that are thought to have
served as early Helmholtz resonators. A Helmholtz resonator (HR) is a simple resonating bass

trap that consists of an air cavity with one or more openings. The sizes of the openings and the

volume of the cavity determine the frequency the resonator will absorb, similar to how a glass
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bottle will produce a characteristic sound when air is blown across the top. A fibrous material
stuffed inside the cavity creates air resistance that converts the vibrational sound energy into heat
energy, dampening the sound. The shape of a resonator can be whatever is most convenient in
terms of construction or aesthetics.

Another type of resonating absorber is the perforated panel absorber (PPA). These are
panels covered in small holes that are mounted onto a wall. The air between the panel and the
wall form what are essentially many small helmholtz resonators. Fibrous material can sometimes
be inserted between the panel and the wall to broaden the frequency range of the absorber. PPAs
are very easy to construct, but they usually do not go much lower than 90 Hz (Foley, 2013).

The next acoustic property worth considering is diffusion. Diffusion is the process of
scattering reflected sound so that it is evenly spread around the room. In an ideal, perfectly
diffuse sound field, reverberation time and sound intensity would be the same no matter where a
listener is positioned. Additionally, a diffuse sound field will have a perfectly exponential decay,
free from irregularities and fluttering effects, which occur when sound interferes with its own
reflection. Although perfect diffusion is not possible in the real world, incorporating diffusive
elements into a room’s design can still improve its acoustic quality. This is done using reflective
surfaces with geometries that scatter reflected sound. Something as simple as a wooden cylinder
would make an excellent diffuser, but more sophisticated solutions also exist. Manfred R.
Shroeder developed a special kind of diffusive element called a quadratic residue diffuser
(QRD). These diffusers have grooves carved into them at various depths based on a
mathematical sequence to optimize scattering across a wide range of frequencies. The same type
of sequences can be used in two dimensions to scatter sound vertically as well as horizontally. A

well-designed studio room should have diffusive elements on all pairs of opposing walls.
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Finally, acoustic treatment must account for external sources of noise. External noise
might originate from ventilation systems, a busy road, or even the footsteps of people walking
around upstairs. If someone sneezes in another room, it should not be audible in a recording.
Realistically, external noise can never be prevented entirely, but with proper planning and
treatment it can be significantly reduced. A brief exploration of potential soundproofing options
is included in the Methodology section, but this is a complex topic that is best left for more
thorough analysis.

Software and Computer Hardware

The organization and output of the video and audio is the central pillar to the success of
any live streaming studio, as making sure the distributor of the livestream has the correct format
and amount of information is crucial. Before anything else, making sure that all cameras,
microphones, and other inputs can be encoded in a livestream software is vital, as encoding
compresses the data gathered from the inputs and sends the more manageable amount of data to
the livestream distributor in a format that can be accessed by any user device. (Live Stream
Encoding, n.d.) Compressing data breaks down the raw feed from the cameras and microphones
into smaller bits of data that can be processed and sent out faster than the raw feed. Encoding is
vital to any good livestream software, and well known software such as OBS, vMix, and
Livestream Studio 6 have encoding built into them.

As for hardware, computers with not only high processing power but also a high number
of ports for USB, HDMI, and possibly even BNC ports are wanted, as it would need to be
capable of handling uncompressed video footage from every camera one chooses to livestream
with. The computer would also need to be capable of connection to a video switch, a device that

can take the inputs from the cameras, livestream software, and any additional media, and allows
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the user to choose which camera and/or graphic to encode in the livestream software. It can be a
physical device that can rest in the control room, but recently some software such has vMix has
made it possible for the video switch to be all digital, reducing the amount of space taken up in
the control room.

Audio Equipment

It goes without saying that microphones are necessary to record and stream audio.
Although many cameras come with built-in microphones, these cannot be repositioned without
moving the entire camera. For top-quality audio and recording flexibility, a studio needs several
dedicated microphones. There are so many kinds of microphones that choosing the right ones
can be a daunting task. Thankfully, most modern microphones fall into one of two categories:
dynamic and condenser microphones. Dynamic microphones operate by using sound energy to
vibrate a conductive coil. As the coil vibrates, it passes near magnets that produce a detectable
electric signal. Dynamic microphones tend to be very durable and can register louder and lower-
frequency sounds than condenser microphones, making them well-suited for instruments like
drums. Condenser microphones contain a diaphragm made out of conductive plates. When sound
hits the diaphragm, the capacitance between the plates changes in a way that can be measured by
an electric circuit and converted into a signal. Unlike diaphragm mics, condensers must be
supplied with 48 volts of “phantom power” in order to function. Fortunately, almost all modern
audio interfaces support this. The diaphragms of condenser mics come in various sizes, where
smaller diaphragms are better for higher-frequencies and larger diaphragms are better for lower-
frequencies. These microphones are more fragile than dynamic mics, but they can also register
quieter sounds, making them well-suited for recording speech. (Wreglesworth, 2022)

There are also other properties that affect how a microphone sounds. Some microphones
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are designed to record sound coming from all directions (“omnidirectional”), while others are
made to only listen in a narrow direction (“cardioid”). (Wreglesworth, 2022) Some microphones
can even switch between multiple polar patterns with an onboard switch. Different microphones
have their own strengths and weaknesses, so it would be useful to have several different
microphones in a studio for an audio technician to select from.

For certain situations, it may be necessary to connect many microphones into one
computer simultaneously. An audio interface is a piece of hardware that allows many
microphones and speakers to plug into a single computer at once. The device “interfaces”
between the digital signals used by the computer and the analog signals used by the microphones
and speakers in a way that preserves as much sound quality as possible (E-Home Recording
Studio, 2022). Interfaces usually plug into a computer through a single USB port, but there are
also products that use thunderbolt or ethernet connections. Knobs on some interfaces allow audio
technicians to easily adjust the signal gain of each input and output, and preamplifiers built into
an interface can boost incoming microphone signals before processing, resulting in a cleaner
sound. Audio interfaces also supply the “phantom power” that condenser microphones need to
function. There are many different audio interfaces available, so it is important to know the
number and type of connections that are needed. Smaller, less-expensive interfaces might only
provide two analog inputs and outputs, while the larger rack-mounted interfaces can support 20
or more. (Sweetwater, 2020)

An audio interface should not be confused with an audio mixer, which combines many
inputs into a single stereo input track. If someone wanted to isolate or remove an instrument after
recording using an audio mixer, they would be unable to do so. Audio interfaces do not combine

signals. Each input goes into its own track in whatever software is used by the computer,
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allowing for much more flexibility in a studio environment. Some mixers do support
multichannel recording as well, but a regular interface is the simpler and more cost-effective
option for our purposes (Sweetwater, 2020).

Finally, a studio needs at least one pair of studio monitors. Similar to home speakers,
studio monitors are used for audio playback. The difference is that home speakers will often
amplify certain frequency ranges to enhance the listening experience, which is not favorable in a
studio environment. Studio monitors are designed to render sounds as accurately as possible so
that any imperfections or imbalances in the sound will not go unnoticed (Neumann, n.d.). Some
modern studio monitors also provide additional features such as the ability to adjust the speaker’s
frequency response to better suit its acoustic environment.

Cameras

Professional video cameras are one of the few parts of broadcasting and recording that
evolves much faster and more efficiently than other parts of broadcasting or live streaming. For
example: In 1997, Sony released the HDW-700, the first video camera capable with HD
recording and broadcasting in 1920 by 1080, previously only limited to movie production. Ten
years later, in 2007, Dalsa debuted the Dalsa Origin 11, the first 4K production camera for film,
and was produced for commercial use. (Camera Profile, 2014) The speed at which improvements
are made to professional video cameras is significant compared to the speed and increase in
quality compared to other aspects of live streaming, and this should be taken into account when
deciding on video cameras for the live streaming studio.

For any live streaming camera that is purchased for the studio, there are a few
requirements that traditionally lead to consistent success. The first thing is the ability to transmit

live HD (1920 by 1080) video to the computer the livestream software is on. Higher resolutions
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give more room for flexibility and would be favored, but the bare minimum for a capable live
streaming studio is high-definition video. The second is being versatile, as cameras that are
capable of doing more than one thing have a longer utility window than those that only do one
thing really well. Cameras that have interchangeable lenses for close shots, portrait shots. and
wide shots have a much higher value than a camera that can only do portrait shots. In addition,
the size of the camera has also contributed to its longevity. Larger cameras that take up more
space often leave less room for other parts of a broadcast or livestream, while smaller cameras
allow for more positions and angles. As a trade-off for its smaller size, these cameras have
traditionally given up performance and versatility to do so, but due to the rate at which video
camera improvements have been made, cameras of similar performance have gotten smaller over
time.
Lighting

Since lighting could refer to anything as early as the first torches being made, the lighting
that this background section will cover will be in relation to cinema production. More recently,
new types of cheap, efficient lighting sources called “ring lights”” have made their way into
mainstream culture for being cheap and available to common people who may not have the
knowledge of how to properly use or have space to place advanced lighting fixtures. On the
professional side, as motors and microprocessors continue to get smaller and smaller, lighting
equipment has gained the ability to move to pre-programmed positions at the push of a button.
This is appropriately called “programmable lighting”, and it allows for more dynamic lighting
during live streaming by removing the need for a lighting worker to manually move the light
each time a person moves on stage. This is particularly good for large stages with significant

room, as it allows for more grand light shows behind the performers. The key, in this case, is to
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find a good balance between the affordability of the ring light and the functionality and
performance of programmable lighting.
Cables

Even as camera, audio, and digital technology has improved year over year, the way that
information moves has had to change very little, and thus many different types of cables are
available for every department as necessary. The XLR cable, or the “X” series latching “L” cable
with a synthetic rubber “R” compound, is a variant of the original type O connector. The XLR
cables were manufactured at a high level as early as 1955 and is still one of the main cables that
transfers audio inputs to audio interfaces (Rouse, 2022). The main types of audio cables that we
will be using are the aforementioned XLR cable, the TRS (Tip, Ring, Sleeve) cable, and the TS
(Tip, Sleeve) cable. The TRS is used for refined and unrefined audio and can carry multiple
audio signals, while TS can only do one track on an unrefined signal. These two are frequently
used to carry unrefined audio inputs from instruments and devices that are not typically used to
record audio, and do not have the space or development to house a whole audio system.

Regarding camera cables, the two major and most commonly used cables for transferring
live video feed are BNC cables and HDMI cables. BNC cables, or “Bayonet Neill-Concelman”
connectors, were designed in the early 1940’s, with the purpose being to quickly connect analog
composite video as well as digital video to other devices, being developed for military use
initially, before seeing more use as an accessible way to transmit video for people who did not
have the means to more expensive or slower ways to transmit video. (BNC Connectors, n. d.)
The largest challenge with camera related cables, however, is that the signal from the cables
needs to be converted to a different cable type, USB, to be read as an input by a standard desktop

computer. USB, or Universal Serial Bus, are standardized types of cables that are the most



common when one is looking to provide an input to a central computer. Recently, USB-C is
becoming the preferred option when looking at USB types due to transmitting faster than

previous types, but USB A, B, and C are all viable options at this point in time.
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Methodology

The purpose of this project is to find a way to completely build and furnish this live
streaming studio while staying under a $75,000 budget. Again, since this would be the only
money to work with, this would be the primary limiting factor. We also have to test to see if the
situation that we talked about actually happens or if something different happens entirely. This
will be most helpful evaluating similar situations in the studio.

Room Acoustics Calculations

In order to properly plan the acoustic treatment of a room, we need to know the exact
dimensions of the space we are working with. In this case, each room is 10x15x10 feet, and they
share a long wall. As mentioned, we will refer to the in which recording takes place as the
“studio room”, and the other room as the “control room”.

We begin by finding the amount of absorptive material the studio room will need for
optimal reverberation time. Different use cases warrant different reverberation times — music
tends to benefit from slightly more reverberation than speech. Everest and Pohlmann (2021)
suggest a music and speech “compromise region” for rooms with a volume of 1,500 ft* between
approximately 0.3 and 0.6 seconds (p. 457). Based on this, 0.45 seconds is a reasonable target.
The Sabine equation is used to solve for total absorption. Ignoring the absorption of the walls
and floor, we find that we need 160 sabins of absorption. Commercial acoustic panels often have
absorptive coefficients of at least 1.0 for high-frequency ranges, so we will need roughly 160 ft?
of acoustic paneling. The word “roughly” is used because certain factors will increase the
absorption. For example, mounting the panels so that they are spaced a few inches from the wall
will increase their effective absorptive area. Also, this number does not account for any furniture,

carpeting, or people in the room, which will increase the absorption further. This is why
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removable paneling is important. An audio technician can measure the room absorption using
specialized software (discussed in the Results section) and then remove or add absorptive
elements as they see fit. A removable floor rug may be preferable to a permanent carpet for the
same reason. In the case of recorded audio, appropriate reverb can even be artificially introduced
with software. The absorptive panels should be spread around so there is fairly even absorption
around the room. Porous bass traps installed in the corners will deal with broad low-frequency
absorption.

The control room follows a different design because it serves a different purpose. The
goal of the control room is to optimize audio accuracy in just a single listening position. A
common way of achieving this is the “live-end dead-end” (LEDE) method, which is detailed by
Everest and Pohlmann (2021). For LEDE, all of the absorptive paneling is placed on the side of
the room with the speakers and listener (the “dead-end”). The opposite “live” end of the room is
treated with reflective diffusers. The goal of the LEDE design is to prevent reflected sound from
interfering with what the listener hears without deadening the room too much. There exist more
complex designs that further improve the listening quality, such as creating a reflection-free zone
using splayed walls, but those are left for future research.

Next, there is sound diffusion. For the case of small studio rooms, Everest and Pohlmann
(2021) state that “In practice, it would be difficult to provide too much diffusion” (p. 458). Going
off of this advice, all the remaining available wall space should be used for diffusion. It is also
important that all pairs of opposing walls should have at least one side with diffusive elements to
prevent comb-filter effects, which occur when sound reflections off a pair of walls interfere with
each other. These diffusive elements could be 1D or 2D quadratic residue diffusers or even

simply large half-cylinders made out of wood. If the diffusers are 1-dimensional, there should be
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a balance of diffusers arranged horizontally and vertically.

Another issue to tackle is room modes. With such a small space, room modes pose a great
threat to acoustic quality. We have already described how resonating bass traps are used to
selectively absorb specific low-frequency tones. The goal is to simply match the resonator
frequencies with the most problematic room modes. This section proposes the frequencies that
should be controlled in order to optimize the frequency response of the room. To analyze and
compare all the possible resonator designs would be too time-consuming, and unfortunately must
be left for future research.

Using the previous equation, a simple computer program was written to compute and plot
the axial, tangential, and oblique modes of the rooms. The resulting plot is displayed as Figure

2.1. The complete python code is provided in Appendix A.
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Figure 2.1: Room Modes Plot. Axial, tangential, and oblique room mode frequencies for a
10x15x10 ft room. Frequencies are rounded to 0.1 Hz before finding degeneracy.

As stated in the Introduction, the modes should be evenly spaced with as few degenerate
peaks as possible. It is worth mentioning that the room modes of the studio are far from ideal,

and a room with these dimensions would not be a great candidate for a recording space.
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Anyways, axial modes should be dealt with first, as they are the most intense. The peaks in the
first plot of Figure 2.1 occur at all multiples of 56.5 Hz, so these should be reduced first. The
peaks at multiples of 113 Hz are threefold degenerate, so those frequencies may require more
resonators to control. If space allows, there are also some tangential modes that could be
controlled such as the peaks at 126 Hz and 252 Hz.

The studio room will also need some form of external soundproofing to reduce unwanted
background noise. Everest and Pohlmann (2021) include several chapters detailing this very
subject. One soundproofing measure one might expect for such a small-budget recording studio
would be soundproof doors designed to create airtight seals when closed. Noisy foot traffic can
be reduced by installing floor padding upstairs, in neighboring rooms, and in hallways.
Ventilation systems can be quieted by installing turbulence-reducing air ducts and/or isolating
the HVAC unit from the rest of the building’s structure using spring mounts. Other measures for
noise reduction include altering the wall’s material and support structure, but this is far outside
the budget and scope of this paper.

Proposed Room Treatment

An example design for acoustic treatment is provided in Figure 2.2. For a fully rendered

3D interpretation of the design, see Appendix B.
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Figure 2.2: Acoustic Designs for the Studio and Control Rooms.
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The plan includes porous absorbing panels, porous bass traps, and two kinds of diffusing
elements. Additional wall space is provided in each room for a television to facilitate
communication between the two rooms while the doors are closed. The studio room contains the
recommended 160 square feet of absorptive paneling divided into 2°x4’ panels of 2” thickness.
Porous bass traps provide some high-frequency absorption due to their material, so this is
counted as well. The wall panels should be mounted with at least a 2 gap from the wall to
improve efficiency. The ceiling of the studio room is covered with polycylindrical diffusive
surfaces to prevent comb filtering with the floor. These ceiling cylinders are included as an
example; differently shaped ceiling panels can provide the same effect. The control room follows
the LEDE design with absorptive panels on one side and diffusing panels on the other. The
resonating bass traps are not included in the diagram, as their exact dimensions and mounting
style are unknown. In any case they should be located near the room’s corners for maximum

effectiveness.
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From this plan, cost estimation is straightforward: count the number of acoustic elements

and multiply them by their unit prices. The cost of the design is summarized in Table 2.1, and the

reasoning behind the vendors is described in the following section.

Element Vendor Count Unit Price | Total Price
2ft x 4 ft Absorptive ATS Acoustics 30 $72 $2,160
Panels (2” thick)
1ft x 4ft Porous Bass Acoustics America 6 $90 $540
Traps
2ft x 2ft x 37 1D BXI 26 $70 $1,820
Quadratic Residue
Diffuser
17.57x17.57x5.5” 2D GIK Acoustics 4 $200 $800
Quadratic Residue
Diffuser

Total: $5,320

Table 2.1: Cost Analysis of Acoustic Treatment

The decision between product vendors was decided based on a balance of effectiveness

and cost. For the absorptive panels and bass traps, the cost and performance is nearly identical

between various vendors, so the decision was based on more arbitrary features such as fire-rating

and color options. Cheap acoustic foam is not included because it tends to have poor mid-

frequency absorption (leads to an unbalanced frequency response) and is usually not fire rated. In

other words, you get what you pay for. ATS Acoustics panels are chosen because of their option

to print custom designs on the panels. The studio could be adorned with a decorative pattern,

wall-spanning decals, the WPI logo, or something else.

For the diffuser panels, the decision of the vendor was based primarily on the lowest cost.

The four 2D QRDs were chosen for aesthetics, and they could be substituted for 1D QRDs if the

budget demands it. Similar to the cheap absorptive foam, there exist significantly cheaper
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diffusive tiles made out of plastic. While inexpensive, these panels tend to be quite small, which
limits their ability to effectively diffuse mid and low frequency sounds (Best Types of Sound
Diffusers: Should You Buy or DIY Them?, 2020). It is worth noting that the diffusive panels are
made out of wood, so they could likely be constructed by WPI students for much less than their
retail prices. For this option, Soundsplash by HX Audio Labs is a convenient free software meant
for simulating the effectiveness of QRD designs based on channel depth (Sound Splash, n.d.).
The ceiling elements and the resonating bass traps are not included in the price estimation as they
would likely need to be custom-built for this room. As with the diffusers, these could also be
constructed by WPI students out of wood or a similar material once the design is finalized.

Treating for external sounds will also add to the budget. A soundproof barrier is only as
effective as its weakest link. For most acoustic spaces the weakest parts are usually the doors
(Everest and Pohlmann, 2021). Special airtight doors will need to be purchased to prevent sound
from leaking through. According to Walker (2021), such soundproof doors can cost anywhere
from $100 to $400 for a solid wood door, depending on the material and size. Additional costs
may include sound treatment for ventilation systems and floor padding to reduce the sounds of
foot traffic in nearby rooms. Analysis of these techniques is left for future research. Finally, a
tube of soundproofing caulk should be used to seal any air holes in the room’s walls, such as
those used for microphone and video cables. A tube of caulk only costs about $15 from ATS
Acoustics.

Audio Equipment

In terms of audio equipment there are many required devices: microphones, stands, an
audio interface, and studio monitors. There are also some optional accessories such as pop filters

and shock mounts. The cost breakdown of all the equipment is summarized in Table 2.2. The
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following paragraphs detail the reasoning behind each product. As with the room design, this list
is just one of many possible studio designs, and higher-end alternative products can be

substituted if the budget allows. The total cost of audio equipment (excluding cables) comes out

to $3,370.

Item Product Name Vendor Count | Unit Total
Price Price

Dynamic SM57 Shure 4 $100 $400
Microphone 1
Dynamic SM58 Shure 2 $100 $200
Microphone 2
Small Diaphragm | VMS ML-2 Slate Digital 2 $150 $300
Condenser
Microphone
Medium AT2020 Audio Technica 2 $100 $200
Diaphragm
Condenser
Microphone
Large Diaphragm | AT2035 Audio Technica 2 $150 $300
Condenser
Microphone
Measurement EMM-6 Dayton Audio 1 $80 $80
Microphone
Shock Mounts GFW-MIC-4248 | Gator Frameworks | 2 $25 $50
Tall Mic Stand MS7701B On-Stage 6 $40 $240
Short Mic Stand | GWF-MIC-0821 | Gator Frameworks | 2 $50 $100
Desk Mic Stand DS7200B On-Stage 5 $20 $100
Main Audio Scarlett 18i20 Focusrite 1 $550 $550
Interface
Secondary Audio | Scarlett 2i2 Focusrite 1 $180 $180
Interface
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Studio Monitors JBL 305P Mkll + |JBL 1 $570 $570
LSR310S
Subwoofer
Studio Monitor GFWSPKSTMND | Gator Frameworks | 1 $100 $100
Stands SK
Total: $3,370

Table 2.2: Cost Analysis of Audio Equipment

There needs to be a selection of different microphones to choose from for different use
cases — live streaming a brass band will warrant different microphones than a strings quartet. At
the same time, there need to be enough microphones of each type to allow multiple voices and/or
instruments to be recorded at once. For the purposes of this design, two edge cases are
considered: a small band of at most six instruments, and a podcast with five voices. Given the
small area of the room, these two cases should reasonably encompass all possible situations. For
a band with loud brass instruments, dynamic microphones are best suited for the job. For upper-
range stringed instruments and human voices, a small-diaphragm condenser would work best.
For lower-range strings and voices, a medium or large-diaphragm condenser is better. Therefore,
a good selection of microphones would include 5 or 6 dynamic microphones and 6 condenser
microphones, with an even split of large, medium, and small diaphragms. There also needs to be
one additional measurement microphone for fine-tuning the room ‘s acoustic treatment.

Microphones can be expensive, so price is an important factor to consider when
shopping. For dynamic microphones, the Shure SM57 and SM58 are two of the most widely
recognized microphones available. Internally, the two microphones are almost identical. The key
difference is that the SM58 has a built-in pop filter to reduce plosives, making it more suitable
for vocals (Henshall, n.d.). Due to their affordability and popularity, all six of the dynamic

microphones can be one of these two. Most bands do not have more than two vocalists, so two
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SM58s and four SM57s seems reasonable.

Next are the six condenser microphones. These are divided into three groups: small,
medium, and large diaphragm size. There are two of each kind, each chosen for their
affordability and good user reviews. For small diaphragms, the VMS ML-2 comes with a switch
that allows it to pick up louder sounds without peaking. For medium and large diaphragms, we
suggest the AT2020 and AT2035, respectively. Both are popular condenser microphones, and
they appear visually nice on camera. The AT2035 also comes with its own shock mount. This
selection of microphones should be sufficient for most use cases.

Pop filters are optional clip-on mesh screens that protect microphones from puffs of air produced
when speaking. These usually cost only around $20, regardless of vendor, so they left out of the
price analysis.

Finally, there is the measurement microphone. This is a special type of microphone used
to measure the frequency response of the room. The website for Room EQ Wizard (REW), a free
software for measuring frequency responses, suggests using the Dayton Audio EMM-6
measurement microphone (Mulcahy, 2022). A later section will discuss how this microphone is
used. The cost of the EMM-6 is $80.

On top of all of this we will need microphone stands and clips (the part that connects the
microphone to the stand). Many microphones come with their own clips, and basic microphone
clips tend to be quite cheap (less than $10 each), so they are excluded from the cost analysis.
Shock mounts are special clips that absorb low frequency vibrations transferred up from the
floor. Gator Frameworks sells cheap shock mounts for $30, so two are included for the studio.
For a band of six standing players, we need six tall microphone stands. The MS7701B is one

such mic stand that can extend from three to five feet tall. There may also be times when a floor-
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level microphone mount is necessary, such as for a cello or a bass drum. For this, the GFW-MIC-
0821 extends only one to two feet. Two of these are included in the plan. For a five-person
podcast, five desk-mounted stands, such as the DS7200B, would be useful. These three brands of
microphone stands were chosen based on their affordable prices and positive buyer reviews. As
always, other similar products could easily be substituted.

Next, there needs to be an audio interface with enough ports to support at least six
microphones simultaneously (continuing with our edge-case example of six instruments). Many
audio interfaces come with more than six inputs, but these are often “line” inputs, which are
meant for electronic instruments and are not necessarily suitable for microphone signals
(Neumann, n.d.). Specifically, an interface must have six microphone inputs in the form of
“XLR” connectors, which is the type of 3-pin input connector used by most microphones. For
this purpose, we recommend the Focusrite Scarlett 18i20 3rd Gen, which costs about $550. It can
be mounted on a tabletop or a server rack, and it has 8 XLR inputs for microphones. This should
be more than enough input. It plugs into the computer with a USB 2.0 connection, but also
requires a source of external power. The reason this interface is recommended over other brands
is that Focusrite is already a widely used brand of audio interfaces. Someone using the studio for
the first time may already be familiar with the brand, and software support for common operating
systems (namely Windows and MacOS) is unlikely to be dropped soon. The 18i20 also comes
with many extra line inputs and outputs if the need for those ever arises.

Professor Bianchi suggests that there should be a computer dedicated solely to audio
editing. The audio computer would combine the microphone inputs into a single stereo track,
while the streaming computer would combine that stereo mix with the video from the cameras.

The purpose of this would be to take some of the processing load off of the streaming computer
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to reduce potential stuttering problems. This comes with the added challenge of finding a way to
send the stereo audio track from the audio computer to the streaming computer without
sacrificing sound quality. While a few software solutions exist, they introduce additional network
latency and are subject to lossy compression. The cleanest solution would be to connect a smaller
secondary audio interface to the streaming computer. The output of the main 18i20 interface
would be connected directly to the input of the secondary one. This comes with the added benefit
of being able to connect the studio monitors to the streaming computer instead of the audio
computer when desired. To keep the brands consistent, a good secondary interface would be the
Focusrite Scarlett 2i2. It is essentially a tiny version of the 18i20 with only two inputs and two
outputs. The 2i2 is small enough that it does not require an external power supply. It needs two
inputs because a stereo track has both a left and right channel.

The control room should have at least two high-quality monitors for stereo playback.
These are audio monitors, not to be confused with digital displays. Professional-grade monitors
are designed to playback audio as accurately as possible. Most studio monitors have similar
audio ranges and features, so choosing the right ones comes down mainly to price and what
brands people trust most. Only two studio monitors are needed, as the LEDE control room
design does not easily accommodate surround-sound systems. The control room would also
benefit from a subwoofer for better playback at ultra-low frequencies. At Professor Bianchi’s
suggestion, we chose to use a pair of JBL 305P MKII 5-inch studio monitors. These are
moderately high-end speakers that cover most of the audio spectrum (43Hz to 23kHz). The
tweeter on the top of the speakers has a horn-shaped inset that is advertised to widen the optimal
listening zone. Switches on the back adjust the high and low frequency output to better suit the

room they are used in. The monitors can be purchased alongside the LSR310S 10-inch
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subwoofer.

The two monitors should also have stands/mounts to keep them acoustically isolated from
the floor. This has the added benefit of raising the speakers off of the table to reduce unwanted
reflected sound. Gator Frameworks sells a pair of desktop monitor stands that costs $100 in total.
Fortunately, a lot of these audio devices are modular. If the need arises in the future, more
microphones or a larger audio interface may be incorporated without drastically altering the rest
of the audio system.

Audio Cables

Finally, there are the cables required to hook everything together. Length, quality, and
connector types are of key concern here. The microphones all use XLR type connectors, but
certain electric instruments require quarter-inch TRS or TS connectors as well. For convenience,
a “snake cable” should run between the two rooms. A snake cable is a thick cable that bundles
many smaller cables together into a manageable tube. Having one or two snake cable extenders
permanently installed between the rooms would allow microphones/instruments in the studio
room to be plugged into the audio interface in the control room. The Hosa Little Bro’ 6x2 cable
contains six XLR extenders and two TRS extenders and costs $76. This would support six
microphones as well as two TRS or TS ported instruments. In the studio room, we will also need
extender cables to attach the microphones and instruments to the end of the snake. There is a
huge variety of these cables available depending on how long and durable they need to be. For
XLR extenders, the example used for cost analysis is the Pro Co EXM-25, which comes with a
lifetime replacement warranty and reaches 25 feet. For the TS extenders we have the Pro Co EG-
20, which has the same lifetime warranty.

Next there are the cables for attaching the monitors and subwoofer to the interface output.



None of these cables need to be very long since the monitors and interface will be right next to

each other. Based on the ports available on the JBL monitors and subwoofer, we will need two
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TRS to TRS cables to connect the subwoofer and two TRS to female-XLR cables to connect the

monitors. The monitors are plugged into the subwoofer, which is plugged into the audio

interface. For TRS to TRS we went with the Hosa CSS-105, and for TRS to XLR we went with

the Pro Co BPBQXF-5.

Finally, there needs to be two more TRS to TRS cables to connect the two audio

interfaces together. The total cost of all the audio cables is listed below in Table 2.3:

Table 2.3: Cost Analysis of Audio Cables

In summary, the total cost of materials for the acoustic treatment, audio equipment, and

audio cables comes out to roughly $9,060.

Audio Software

The last piece of the audio puzzle is the software. Digital Audio Workstations (DAWS)

Cable Type Product Count Unit Total
Price Price
Room-to-room Snake Cable | Hosa Little Bro’ 6x2 251t 1 $76 $76
Studio Snake-to-microphone | Pro Co EXM-25 6 $30 $180
Studio Snake-to-instrument Pro Co EG-20 2 $21 $42
Interface to Subwoofer and Hosa CSS-105 4 $8 $32
Interface to Interface
Subwoofer to Monitor BPBQXF-5 2 $20 $40
Total:  $370

are software packages that are used to edit audio tracks. There are many DAWSs available

depending on your needs and budget. These days there are even fully-featured DAWSs that are

completely free, such as Audacity and Garage band. Unfortunately for our use case, most DAWSs
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are not designed with live-mixing in mind. This can be an issue if the audio software cannot keep
up with the rest of the stream, causing noticeable lagging or stuttering. This is why we
recommend Ableton Live, as it is one of the only DAWSs that is specifically advertised to work in
a live setting, ensuring optimal performance. A regular license of Ableton Live costs $450. For
instances when live audio is not necessary, the audio computer can be loaded with a couple of
other DAWs that the user can choose from based on personal preference. For this we suggest Pro
Tools. In the case of two computers, these packages should be installed on the audio-specific
compulter.

Video, Lighting, Livestreaming Software

Considering software for other parts of the studio, the video software should be
something that is capable of handling a couple of inputs very well, while also having the ability
to add onto the video with effects if needed. OBS is a capable software and it’s free, but it is very
limited in what it can do because its only free. In this situation, vMix would be more capable and
applicable to this situation. It can create overlays, has several transitions on said overlays and
from video-to-video input, and can combine audio input with video input and encode it, making
it ready for livestreaming without the livestreaming software needing to encode it. At $700, it is
pricey, but it is a lifetime purchase with 4K streaming quality with nearly every tool in vMix’s
arsenal.

Moving on to lighting and livestreaming software, many different options pop up for
livestreaming, as active lighting during live performances is often a necessity, and livestreams do
not happen without a platform to put them on. For the livestreaming software, Vimeo is actually
the preferred option, due to the ability to transmit the livestream to other platforms in addition to

Vimeo, who also streams in 4K. The advanced plan, which seems pricey at $65/month, is
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actually decent considering it contains the ability to go to other platforms as well, meaning you
are not limited to one site. As for lighting, Lightjams is a simplistic program to get active
lighting up and running, and will be great for students who have never worked lighting before,
while still having many functions for more experienced people to use. The most effective option
for the studio at the month is the $125 Express version, which is a lifetime purchase, does
everything that the lighting rig available allows Lightjams to do.

Video Cameras

The tricky part about finding the right camera for a studio of this size is finding a camera
that both balances simplicity and ease of use with range and compatibility and balancing cost
with quality. Adding a simple and cheap camera like the Mevo Start Live Streaming Camera
may seem like a good option at the time, due to the 1080p streaming quality, remote control via
Mevo app, and built-in microphone, but there are always tradeoffs. For example, there is no
manual color correction, meaning that any imperfections in the camera’s color streaming have to
be adjusted instead with the lighting, which, as is discussed later on, will involve changing six
lights. In addition, there is no physical output port, meaning that not only will the latency of the
video feed be subject to the connectivity of the Mevo and streaming computer, but also that all
production must go through the third party Mevo app, slowing down the video feed even longer.
The ethernet power adapter Any latency by the video feed means that the audio and video inputs
must be synced up, taking up even more time that could be used elsewhere. Though there is a
USB-C port on the back that looks like it can be used for video feed, however the Mevo website
strictly states that it is for audio and power only, neither of which can be used because there will
already be direct audio input via the above section, and the Mevo cannot charge and stream at the

same time.
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Mevo 112HEA

Figure 2.3. Backside of the Mevo Start Live Streaming Camera. Notice the lack of physical
output ports, and any sense of adjustability on the actual camera itself.

Knowing this, another problem arises: Each camera has its own tint to it, a slight shade of
color it reads the world as. Knowing this, it will be difficult to use multiple different cameras on
this streaming studio, as changing the lighting to correct 1 camera may make the other camera’s
tint worse. The answer, then, is simple: Have 3 of the same camera. This solves the issue of
having to color correct each camera, but also necessitates that each camera be versatile enough to
handle many different types of shots and angles.

This leads to the Canon XA11 Professional Camcorder. With full 4K live streaming
video quality, the XA11 can provide full clear image quality, with a minimum distance of 2 feet
for maximum resolution. Capable of both recording and streaming, it has a lens attachment clip
that allows for different lenses and filters for a much wider array of shots, has a separate power
source for both battery and wall plugs, and has a touchscreen for better accessibility. This covers

most of the preferred qualities of a camera for the studio, but there are two aspects that
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significantly hurt it: cost and ease of use. The XA11 costs $1,689 per camera, which essentially
puts it out of the price range, as that price tag is the camera by itself, not including necessities
such as a memory card, camera case, and tripod. In addition, the camera requires at least some
levels of knowledge about photography and film technology in order to use all the functions of
the camera, which may make it a poor choice for students looking to start getting into a live
streaming lab.

With these considerations in mind, the most efficient and likely best camera to choose
would be the Blackmagic Design Pocket Cinema (4K). Full touchscreen, interchangeable lenses,
HDMI, USB-C, and XLR ports, battery powered and cord powered, 4K streamed and recorded
video quality, and 64GB of memory included. The price, at $1,295, may seem a bit steep at first,
but considering that both spare battery, 64GB memory card, and case are all included, it comes
out as significantly higher value than competitors, especially the XAl11, which by itself was $400
more. Due to its versatility, ease of use, and cost, the Blackmagic is the best option for this

livestreaming studio.
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Figure 2.4. Blackmagic Design Pocket Cinema (4K) with Battery and 64GB Memory Card.

Video Cables & Accessories

Now that the camera is selected, the connections between the camera and the streaming
computer should be considered. The Blackmagic has both an HDMI and a USB-C port, as well
as an XLR port for audio if needed, but since the studio will have its own microphones, this will
not be needed as often. The computer will have HDMI ports, but since USB-C ports are
relatively newer, it may need a converter from USB-C to USB-A, having the HDMI be the
primary mode of transmission between the camera and streaming computer may be important.
For these HDMI cables, we will use Cable Matters 48Gbps 8K HDMI cable. This will also
connect the monitors of each station to their respective computers. The camera also needs a

stable place to stand, so we will use the CAMON 72 inch Heavy Duty Tripod for each camera,
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which will allow students to change the height and placement of the cameras as necessary.

Having ethernet and USB switch, or nodes that combine cable inputs into one unit, will help

reduce the number of wires in the studio, which will help keep track of cable management. In

total, the price for the video section of the live stream studio should come out to the following:

Item

Product Name

Vendor

Count

Unit Price

Total
Price

Livestream
Camera

Blackmagic
Design Pocket
Cinema (4K)

Adorama

$1,295.00

$3,885.00

Wide Lens

Meike 25mm F1.8
Large aperture
Wide Angle Lens

Amazon

$74.99

$74.99

Normal Lens

Meike 35mm F1.7
Manual Focus
Prime Lens

Amazon

$69.99

$139.98

Tripod

COMAN heavy
Duty 727
Professional
Video Tripod

Amazon

$139.99

$419.97

HDMI Cables

Cable Matters
48Gbps 8K HDMI
Cable (6.6ft)

Amazon

$10.49

$62.94

USB-A Switch

Ugreen USB 3.0
Sharing Switch (4
Port, 2
Computers)

Ugreen

$40.00

$40.00

Ethernet Switch

NETGEAR 5-Port
Gigabit Ethernet
Unmanages
Switch (GS305)

Amazon

$22.99

$22.99

USB-A Cables

Mediabridge USB
3.0 (8 Feet)

Amazon

$14.99

$74.95

Table 2.4. Total Cost of Video Transmission.

Total:

$4,720.82
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Lighting & Other

Lighting may seem like a daunting task for this specific situation, but it is actually
relatively simple. All that needs to be done is to cover the center of the room in light from
multiple angles to ensure that all areas of the subject are appropriately lit. Because the room
itself is rather small (10 feet x 15 feet), there does not need to be that many lights. Because of
this, the Chauvet DJ 6 Spot RGBW 6x9W System would be excellent for this. At only $309, it
has 6 spotlights that can change color with another input from a computer in the control room,
via Lightjams. It has a simple DMX in and out port that requires XLR cables, for which we
already have the snake cable. The only trouble would be mounting it to the wall or ceiling, but

once it’s there, it takes up very little space.

Figure 2.5. Chauvet DJ 6Spot RGBW 6x9W System.

With the lighting in place, the main component left is the uninterruptable power supply to
make sure nothing happens to the power being supplied to each system during the live stream.
Two will be needed: one for the studio and one for the control room. They should each be
capable of handling all of the computer, audio, and video systems in the room. For this, the APC
1500VA UPS Battery Backup and Surge Protector would be best suited due to its high capacity

in both Watts and Volts, at only $169.
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Results & Findings

Computer Hardware Installation

When processing live footage, a powerful computer is essential. The first thing to
consider is the hard drive. When editing video, you have to consider the 1/0 performance of the
host. 1/0 performance is the input and output of data, that is, the data flow and data throughput
per second. In particular, the data volume of 4K is more than 4 times that of HD, which brings
huge pressure on computing and storage systems. The host needs to have strong 1/0 performance
to guarantee it. The overall 1/0 performance of the host includes not only the hard disk speed,
but also the motherboard interface speed, motherboard frequency, memory size, memory
frequency, dual-channel memory, CPU L3 cache size, and the memory frequency supported by
the CPU. Nowadays, the configuration performance of computers is becoming more and more
powerful, but in the entire computer system architecture, compared with the CPU and memory,
the speed of the hard disk is the weakest device in the PC. Computer CPU + cache + memory +
hard disk + graphics card is more like a relay race combination. The speed of the whole
combination is related to each component, and the baton is data. Often the baton is passed to the
hard disk and it lags behind. An ordinary mechanical hard disk, the speed is generally 100MB/s,
and it can only reach 30MB/s when it is lower. The transmission speed required for editing 4K
material is 400M/s, so the speed of the array needs to be increased, and the speed of the array
with RAID5 can reach 420MB/s. Enough to edit in 4K. The speed of solid-state drives is faster,

and now the speed of solid-state drives is 500M/S.
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Parameter SSD HDD
Abbreviation of Solid State Drive Hard Disk Drive
Cost (Estimate) $80 for 1 TB $40 for 1 TB
1/0 Performance 6000 io/s 400 iofs

Weight 0.1 Pounds 0.3 Pounds

Durability Roughly 5x Compared to 1 Failure ~ 300,000 Hours

HDD
Energy Consumption 2-5 Watts 6-15 Watts
Life Span 10+ Years 3-5 Years
Noise Low Noise Moving Parts Produce
Notable Noise
Technology Integrated circuit using Flash Spinning Disks/ Platters
Memory
Target Devices Modern Laptops Desktops & PCs

Table 3.1. Comparison of SSDs and HDDs.

The second consideration is memory. Memory is a must for anyone who relies on a fast
and efficient computer to edit video. Video editing software uses more RAM (random access
memory) than most computers have, and without enough memory, it's almost inevitable that your
computer will crash or freeze while editing video. The exact amount of memory required for
video editing will depend on the software you are using, the type of movie you are editing, and
the number of different applications or programs you are using at the same time. For a smooth
video editing experience, you may need to add more memory. Increasing memory is critical to
all aspects of the video editing process, and is recommended for any video editor looking to
revitalize a slow machine. RAM (Random Access Memory) is the short-term memory of your
computer that allows you to access multiple programs at the same time very quickly and
efficiently. In contrast, a computer's mechanical hard drive, or solid-state drive, is long-term
storage that keeps information longer. Whether editing emails, documents, or videos, these tasks
require RAM. How much RAM you need depends on the type of work you're doing and how
many things you're doing at the same time. For video editing, the memory capacity of your

computer or laptop is critical to your workflow. Without enough memory, the computer cannot



43

perform the required tasks, and video editing becomes unnecessarily difficult. Simply put, the
more RAM a computer has, the faster it runs. You need enough free memory for your computer's
operating system to load, to open the video editing software you need, to edit video easily, and to
keep your computer's background tasks running. Also, you might want to take into account that

any other apps that are open, such as OBS, also require a lot of your computer's RAM.

7 Task Manager - O X
File Options View
Processes Performance App history Startup U:Is', Details Services
13% ~ 60% 0% 1%
Name Status CPU Memory Dk Network
A et 87% 26763MB  0.1MB/s OMbps °
€ Google Chrome (25) 1.5% 1303.0MB 0.3 MB/s 0 Mbps
9 Steam Client WebHelper (8) 04%  408.7MB 0MB/s 0 Mbps
(8 Antimalware Service Executable 0.1% 203.4M8B 0MB/s 0 Mbps
& Discord (32 bit) (3) 0.1% 1788 MB 0 MB/s 0 Mbps
@ 08 Studio (2) 09% 151.3M8 OMB/s  6.5Mbps
(7] obs-browser-page 0% 349M8 0MB/s 0 Mbps
Service Host: Diagnostic Policy ... 0% 316 MB 0 MB/s 0 Mbps
v Windows Explorer 0% 31.2M8 0MB/s 0 Mbps
Xbox Game Bar (3) 0.1% 300 MB 0.1 MB/s 0 Mbps
B NVIDIA Share 0%  293Ms 0 MB/s 0 Mbps
¥ Task Manager 0% 23.1 M8 0MB/s 0 Mbps
. NVIDIA Container 0% 2.0MB 0MB/s 0 Mbps
%' Desktop Window Manager 05% 21.2M8 0MB/s OMbps
< >
Fewer details End task

Figure 3.1. Example of Memory Usage while Streaming on OBS.
64GB is the most efficient computer RAM capacity for video editing. With 64GB of
RAM, you can run multiple programs simultaneously while still being able to edit and preview
videos without spending excessively on options that might otherwise never get used. 64GB lets
you do everything you need for video editing without slowing down your workflow.

The third point to consider is the CPU. All video codec work requires the CPU to handle,
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and the CPU is the data center in the entire clip. Therefore, the CPU, like the motherboard, is
also a bridge between the memory and the hard disk. The processing speed of the CPU affects
the speed of data flow. At the same time, live streaming can also put a strain on the computer.
This pressure is also the first thing to pay attention to is the push flow. In the case of OBS, the
mainstream encoder is X264. Using X264 for the encoder can achieve significantly better results
than other encoders. Specifically, when using the CPU to push the stream and the graphics card
to push the stream, the picture of the CPU push is more refined than that of the graphics card. So
what are the substantive requirements for the CPU? For the CPU, the higher its main frequency,
the more operations per second, and the faster the calculation speed. The greater the number of
cores and threads, the stronger the parallel computing capability and the higher the overall data
processing efficiency. Like when editing video, a multi-core/multi-threaded CPU makes preview

generation much faster.
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PC Specs: RTX 2080 Ti, 64GB of RAM, Samsung 960 Pro 1TB,
Software: Windows 10 Pro (1503), Premiere Pro 2020 (ver. 14.0), PugetBench V0.8 BETA for Premiere Pro
Figure 3.2. Scores for CPUs, Courtesy of Puget Systems.
As can be seen from the figure, when the CPU has more core counts, its comprehensive
ability in processing video will be stronger. There will be no stuttering and so on. The following

is the resulting cost of the streaming computer now that every part has been decided:

Item Product Name Vendor Count Unit Total
Price Price
CPU Intel Core i9- Intel 1 $650.00 | $650.00
9900X, 10 Core
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Motherboard

EVGA X299
Micro

Amazon

$287.99

$287.99

CPU Cooler

Hyper H412R
CPU Air Cooler ‘4
Heat Pipes

Cooler Master

$32.99

$32.99

Case

Fractal Design
Focus G — Mid
Tower Case -ATX

Newegg

$62.00

$62.00

Graphics Card

Asus Radeon
ROG-STRIX-
RX560-04G-GA

AsuUs

$250.00

$250.00

RAM

Crucial 32GB Kit
(16GBx2) DDR4-
2133 MT/S(PC4-
2133) CL15 Dual
Ranked X4Based
ECC Registered

Server Memory

Amazon

$105.27

$210.54

Storage

Samsung EVO
970 Plus 1 TB
Pcle Gen3 x4
NVMe M.2-2280
Internal Solid
State Drive
(1024MB Cache
Memory)

Samsung

$96.00

$96.00

Power Supply

EVGA
SuperNOVA 1000
G5 Power Supply

Amazon

$179.99

$179.99

Monitor

Sceptre E248W-
19203R 24” Ultra
Thin 75Hz 1080p
LED Monitor

Sceptre

$95.98

$191.96

Thermal Paste

Arctic MX-4 (8
Grams) Thermal
Compound Paste

Amazon

$6.65

$6.65
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Wireless
Computer Mouse

Keyboard Logitech MK270 | Logitech $29.00 $29.00
Wireless
Keyboard

Mouse Logitech M510 Logitech $17.50 $17.50

Camera Installation

Total: $2014.62

Table 3.2. Total Cost of Streaming Computer.

In order to test the hypothetical solution stated under the video camera section in

methodology, an initial livestreaming test using a standard Nikon D5300, and using the

livestreaming software vMix. The first step is to see the available ports and determine the best

connection port to live stream the video from the D5300. Below is the available ports on the

D5300.

’

!

Figure 3.3. Available ports on the D5300, which include Mic Out, A/V Port, and HDMI.
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In the absence of a BNC port, the mini-HDMI connector was used to take out the HD
video from the D5300 to the laptop with the livestreaming software vMix. However, the intial
connection failed because the mini-HDMI to HDMI cable used did not use a converter to switch
the HDM I signal to USB-C, one of two input ports on the laptop. An additional HDMI to USB-C
converter and USB-C cables were added to the connection between the D5300 and the laptop.
Using this, the laptop successfully read the camera as a visual input. A Blue Snowball
microphone was also plugged into the laptop in the USB-A slot, with the laptop reading the
microphone as an audio input faster than the camera.

After this, vMix was downloaded and booted up. Two new inputs were created via the
“Add Input” tab in the bottom left. One for the D5300 and one for the Snowball, both of which
took very little time. After that, it was discovered that the visual input for the D5300 would shut
off every 30 min, requiring a manual restart. Several hypotheses were made, but the ultimate
reason came down to international tax law. According to the Explanatory Notes of the Combined
Nomenclature of the EU, On the 23" of October, 2007, Official Journal C248, Section 5, Pages
5-6,

“In general, the digital video camera recorders of these subheadings have the design which
differs from digital cameras of subheading 8525 80 30. They often have a foldable viewfinder
and are frequently presented together with a remote control. They always offer an optical zoom
function during video recording.

These digital video camera recorders may also have still image recording capability.

Digital cameras are excluded from these subheadings if they are not capable, using the maximum
storage capacity, of recording, in a quality of 800 x 600 pixels (or higher) at 23 frames per

second (or higher) at least 30 minutes in a single sequence of video.” (European Commission,
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2007)

Now, because of this “digital video camera” manufacturers needed to trim the maximum
recording time of most video cameras down to below 30 minutes, so as not to increase the tariff
on their products from 4.9% to 14%, thus driving down demand for their product. As a result, the
Nikon D5300 cannot record or stream for longer than 29 minutes and 59 seconds at a time. This
issue will be resolved once the Blackmagic is purchased for the studio, but for now, the proof of

concept receives all inputs and is ready to stream.

Figure 3.4. Full Proof of Concept for the Livestreaming Studio.

Wiring
The wiring for the audio equipment is fairly simple, and all the necessary wire types are

detailed in the audio cables. Figure 3.5 is provided as a visual aid for hooking everything
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together. The cable connection types are indicated in small letters. To pass the snake cable
between the studio and control rooms, a hole must be drilled through the wall. After all the
wiring is complete, the edges of the hole should be sealed with caulk to create a soundproof
barrier. Figure 3.5 does not include external power connections. Some electronic instruments in

the studio room may also require external power.

STUDIO ROOM CONTROL ROOM
TRS + XLR(m) ,
Snake Cable Hub Audio Computer
XLR(m) TS * k
A A A A AL A A Primary Audio uss
Interface
TRS TRS (Output)
TRS TRS (Input)
YYVYVYVY vy
XLR() $ % Subwoofer | | 4 = merface
aaaaaasa
TR
Microphones Instruments Monitor L || Monitor R Sct;‘:f&itl?

Figure 3.5: Audio Equipment Wiring Guide.

Camera wiring is not as challenging either, as the video input cables can be plugged
directly into the streaming computer using an extension cord between the rooms, as the
streaming computer will have enough ports without the need for an additional accessory to
manage the video inputs. As for power, primary power strips should be laid in each room,
Because every device listed, with the exception of microphones, instruments, and the snake cable

hub needs to be connected to a wall outlet.
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Acoustics Calibration Using Room EQ Wizard

Once all the hardware is in place, you can begin adjusting the acoustics of the room using
a free software called Room EQ Wizard (abbreviated as REW). The EMM-6 calibration
microphone should come with a downloadable calibration file used by REW to remove bias from
the input signal. REW will also need to generate a calibration file for the audio interface. To do
this, the output of the interface must be plugged directly back into its input. Then run the
calibration program built into REW, which will generate the file. After the hardware calibration
is finished, the software is now ready to take measurements of the room’s frequency response.
These measurements are used to find the optimal listening position, speaker placement, and
amount of absorptive paneling. They can also reveal unexpected acoustic defects in the room that
may require additional treatment. The specifics of using REW are outside the scope of this paper.

More in-depth tutorials are available on the internet and on the REW website.



52

Manuals on How to Operate the Studio

How to Power on the Studio:

NOTE: Do not unplug the UPS when you are powering on and off the studio! This will damage
the UPS and may decrease its lifespan.

1. After turning on the light switch, turn on the power strip for the audio interface, mixer,
and main streaming desktop, which should all be connected to the same power strip.

2. Once the power for the desktop is on, load on the lighting program Lightjams.

3. After Lightjams is on, press the power switch for the power strip for the Chauvet lighting

fixture.

Figure 4.1. Blank Lightjam Project; Opens when the Lightjam Application is Loaded.

4. After the lighting fixture is turned on and you can see that all lights have power, load the
lighting preset “Baseline” in Lightjams.
- Go to “File” > “Open” > “Baseline.ljp”. All openable files in Lightjam are .1jp files.

This will bring up the lights to a normal, white light that can be adjusted if needed, but
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will be good for most use cases.
How to Add a Camera in vMix:

1. Select the camera that you want, and check the ports on the side to see what type of cable
it needs.
- If it has a small circular port, it requires a BNC connector.
- Ifit says “HDMI” next to a trapezoidal pin, it requires a HDMI cable.
- Ifit has a little square of clear plastic, it requires an ethernet cable.

2. Connect the camera to a power outlet, or insert a battery, and power the camera on and

activate the “Live Capture” function, usually a lever on the side of the camera.

Figure 4.2. Live Capture Lever (LV) on a Nikon D5300 Camera.
3. Attach necessary video cables from auxiliary ports to the inputs on the desktop.

4. Open vMix on the desktop. An empty project should appear on the screen.



addvpt - A Recon & Exena

97 EX FPS: 20 RenderTime: 0 ms GPU Mem: 15 CPUvMbe 0% Totak 25 %

Figure 4.3. Blank vMix Project

5. Go to “Add Input” > “Camera” and look for the name of the camera you just turned on.

HP Wida Visan FHD Canera
| Dedmk
dion. 132061080

o [NTSCZ9%

a | Defak

do Device | Bult In Audilo

How to Add an Audio Input in Ableton Live:
1. Decide whether the audio input is a microphone or an instrument and choose the
appropriate output cable.

- For microphones, an XLR cable is needed.
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- For instruments, a TS cable is needed.

2. Connect the output cable to the snake cable hub. This will allow the primary audio
interface to pick up the audio input.

3. After everything is connected, open Ableton Live, select a track, and go to “Live” >
“Preferences” > “Input Config” and choose the audio input.

How to Set up a Livestream:

1. Assuming everything is powered on and connected, go to the streaming computer with
vMix on it and confirm that Ableton Live’s output audio is connected to vMix’s input
audio.

- If Ableton Live does not output audio, go to “Live” > “Preferences” > “Audio
Device” and choose the streaming laptop as the output. Additionally, in the
“Preferences menu go to > “Output Config” and confirm that Ableton Live is sending
audio outputs 1&2. This should output the audio from the audio computer to the
streaming computer.

- If vMix does not recognize any new audio input, go to “Add Input” > “Audio Input”
> Select the USB port connected to the audio computer.

2. On vMix, the green is the video that is the current output, with the yellow window being
the video input on standby. Load the input video that you want into the green window by
clicking on it.

3. Test the audio outputs using the headphones to check that everyone’s audio levels are
appropriate.

Sending a Livestream to Vimeo:

1. Once you have everything ready to go, go to “Stream Settings” > “Destination” and
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select Vimeo.

- Check to make sure that the quality is set to H264 1080p.

Click “Start 1”.

Go to Vimeo and select “Library” > “New Video” > “Create Event” > “Choose Event
Type” > “Next”

. Input the information about the event you are livestreaming, and click “Next”.

Select “Stream with Vimeo” under “Manage Production”, and click “Start Event.”
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Every technical part of the proposed live streaming studio has been thoroughly analyzed,

considered, and built upon by the next component. The proof of concept for the video camera

and livestreaming software is functional, and can be built upon for the final product. Each part

has been properly planned. The total cost for all technical aspects of the livestreaming studio is:

All this, however, is simply a proposal for the technical side of the lab. Labor costs, tax,

Section Name Price
Acoustics Acoustic Treatment $5,320.00
Audio Audio Equipment $3,370.00
Audio Audio Cables $370.00
Software Ableton Live $450.00
Software Lightjams $125.00
Software vMix 4K $700.00
Software Vimeo Advanced+ $780.00
Video Video Transmission $4,720.82
Lighting & Other Light Rack and UPS $647.00
Encoding Streaming Computer $2,014.62
Total: $18,497.44

Table A: Total Technical Cost of Proposed Live Streaming Studio.

furniture, and any unexpected maintenance costs beyond the first year are not accounted for. And

all of this is just hypothetical. The only way to know for certain that all this is correct is to

actually build and test it. After all, it’s okay to aim higher than previously thought.
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The Python code used to generate the mode frequency graph seen in Figure ## is included below.

import matplotlib.pyplot as plt
import numpy as np

from collections import Counter
import math

# CONSTANTS #

Cc = 1130 #Speed of sound in feet per second

L,W,H = 10,15,10 #Room dimensions in feet

#Graphing and calculation parameters

X MIN = 10 #Min frequency in Hz

X MAX = 400 #Max frequency in Hz

MAX MODE = 30 #The maximum number of loops when calculating modes. You probably
don't need to change this.

ROUNDING = 1 #The number of decimal places to round the frequencies to
# CALCULATE MODES #

a fregs = [] #Axial mode frequencies

t fregs = [] #Tangential mode frequencies

o fregs = [] #Oblique mode frequencies

def get frequency(p,q,r):

#Gets frequency given mode numbers

return C/2 * math.sqrt ((p/L)**2 + (q/W)**2 + (r/H)**2)

for p in range (0,MAX MODE) :
for g in range(0,MAX MODE) :

for

#Counters

a_counter =
= Counter (t fregs)
= Counter (o_freqgs)

t counter
o_counter

r in range (0,MAX MODE) :

freq = round(get frequency (p,q,r),ROUNDING) #Calculate frequency

if freqg<X MIN:

continue #Ignore out-of-bounds frequencies

elif freg>X MAX:
break #Don't need to calculate

#Add mode to appropriate List

if (p+g==0 or p+r==0 or g+r==0) :#Mode is
a_ fregs.append(freq)

elif (p==0 or g==0 or r==0): #Mode is
t fregs.append(freq)

else: #Mode is
o _fregs.append(freq)

keep track of how many times a particular
Counter (a_freqgs)

any higher modes

Axial
Tangential

Oblique

frequency appears in the List

#

PLOTTING

fig, (axl,ax2,ax3) = plt.subplots(3)

#Axial Mode Plot

x vals = 1
y vals = 1

ist (a_counter.keys())
ist (a_counter.values())

axl.bar (x vals,y vals,color=(250/255, 142/255, 10/255))

axl.set x1
axl.yaxis.
axl.set ti

im ([X_MIN, X MAX])

set ticks(np.arange (0, max(y vals)+1l, 1 if max(y vals)<4 else 2))

tle ("Axial Modes")
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axl.set (ylabel="Mode Count")

#Tangential Mode Plot

x vals = list(t counter.keys())

y vals = list(t counter.values())

ax2.bar (x_vals,y vals,color=(7/255, 237/255, 34/255))

ax2.set xlim([X MIN,X MAX])

ax2.yaxis.set ticks(np.arange(0, max(y vals)+1l, 1 if max(y vals)<4 else 2))
ax2.set title("Tangential Modes (-3dB)")

ax2.set (ylabel="Mode Count")

#Oblique Mode Plot

x vals = list (o _counter.keys())

y vals = list (o _counter.values())

ax3.bar (x vals,y vals,color=(26/255, 69/255, 240/255))

ax3.set xlim([X MIN,X MAX])

ax3.yaxis.set ticks(np.arange (0, max(y vals)+1l, 1 if max(y vals)<4 else 2))
ax3.set title("Obligque Modes (-6dB)")

ax3.set (xlabel="Frequency (Hz)", ylabel="Mode Count")

#Display Plots

fig.suptitle ("Room Modes at Low Frequencies")
plt.tight layout () #Formatting fix

plt.show ()
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Appendix B
3D renders of the example room design shown in Figure 2.2. Room dimensions and wall-

mounted panels are all to scale. The size of the doors, television screens, table, and monitors are
all approximate. Resonating bass traps are not shown. Colors are chosen to distinguish between
materials and are not representative of the final aesthetic design. Modeled in Blender and
rendered with Cycles. All textures are attribution-free.

Top-Down View:

Studio Room:

Control Room:




Appendix C

Flow chart of the proof of concept for the camera and central streaming computer.
. Mini-HDMI to @@HDMI to USB-
Nikon D5300 ~ HDMI Cable \\ USB-C Cable \
Snowball | USB-A Cable !
Microphone —
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